
Introduction

Thank you for purchasing Notion.  We hope that you will find it to be a useful enhancement to
your Newton system, and that this manual will help you to make both Notion and your Newton
even more useful.

What is Notion?

Notion is a tool for creating and managing lists of things-- anything.  Using Notion, you can
then sort your lists, search them, and create archives.

Notion also includes several tools to help you work with lists. You can use Converge to merge
data from two different lists, Manage to designate which lists you want to be available for
quick access, Browse to create new lists from templates, and Design to create new templates.

Installing Notion

To install Notion, first copy the Notion packages to the hard drive of your desktop computer.
You can then use either the Newton Package Installer or the Newton Backup Utility to install
the packages onto your Newton.

Note: If you have a previous version of Notion already installed on your Newton, you must
remove it before installing Notion 1.5. To do this, open your Extras Drawer, and make the
"scrub" gesture over the Notion icon. Any Notion Extras installed (Browse, Converge, Manage,
and Design) should also be removed.

Notion 1.5 is provided in a modular format. Below is a list of all the packages and their sizes:

Mac Filename Windows Filename Description Size

Notion.pkg notion.pkg Application 158k
Browse.pkg browse.pkg Browse Extra 27k
Converge.pkg converge.pkg Converge Extra 18k
Manage.pkg manage.pkg Manage Extra 32k
ListDesigner.pkg design.pkg List Designer Extra 68k
Online Help.pkg help.pkg Online Help 18k

Notion Connect \connect Directory
Connect.pkg connect.pkg Connect Extra 23k
Notion Connect connect.exe Connect Desktop App

Templates \templts Directory
Builtin.pkg builtin.pkg Built-in Templates 14k
Business.pkg business.pkg Business Templates 45k
Leisure.pkg leisure.pkg Leisure Templates 36k
Personal.pkg personal.pkg Personal Templates 36k
Reference.pkg refernce.pkg Reference Templates 59k

All of the above packages except for the Notion 1.5 package are auto-parts, meaning that they
appear only in the "Extensions" folder of your Extras drawer.



Removing Notion from your Newton

To remove Notion, follow the instructions in your Newton user's guide for removing an
application. If you wish to remove the Notion Extras, they are installed in the Extras Drawer's
"Extensions" folder.

To remove all your Notion lists, open the Extras Drawer to the "Storage" folder, and make the
"scrub" gesture over the Notion icon.

Starting Notion

There are two ways to start Notion:

1. Open the Extras drawer, and tap on the "Notion" icon.   This will open Notion to the
last list you worked with.

2. Tap on the Notion status-bar button. This button will either open Notion to the last list you
worked with, or give you a list of active lists. The button's behavior is controlled by a
preference in Notion.

Note:  The status-bar button is disabled when you first install Notion. To enable it, you must
open Notion and enable it from the Prefs slip. See the Preferences chapter for instructions.

Hiding Notion

You can hide Notion to quickly access other features of your Newton. Notion may be hidden by
tapping on the Hide button, in the upper-right corner of the Notion display.

Note that when Notion is hidden it is still running, but is simply not visible. This means that if
Notion is installed on a memory card, for instance, you cannot remove the memory card without
getting an error message.

Making Notion the Backdrop Application

If you use Notion frequently, you can make it the “backdrop” application so that is opens
automatically every time you turn on your Newton.  You can make an application the backdrop
application only when it’s stored internally—not on a card.  Follow these steps:

1.  Tap Extras to open the Extras drawer.
2.  Hold the pen on the Notion icon until you see the highlighting mark.
3.  Tap the Action button and then tap Make Backdrop.
4.  Tap OK in the box that appears.

Note that there is no close box in the Notion status bar when it’s opened as the backdrop
application. This is because Notion is always open when it’s the backdrop. To use another
application, you  must open it on top of Notion.

Information for users of previous versions of Notion.

There are some changes from Versions 1.1 and 1.2 of Notion.

Status Bar



The buttons on the status bar at the bottom of the screen have changed. The appearance of some buttons
have changed, as well as the features available through the buttons. These changes are described in this
section.

1.  The clock has been replaced by the Info button, which looks like an “i.” Tap the Info button for the
Info, Prefs and on-line Help features (formerly the Preferences and About Notion features were in the Notion
button).
2.  The Notion button no longer includes the Prefs or About feature.  It now includes the Duplicate
list,  Delete list, and Rename list features.  Also, a Scroll to Top and Scroll to Bottom
feature has been added to the button.
3.  The Utility button is now called the Notion Extras button and looks like a toolbox instead of an apple
or an "E".  The Notion Connect feature is included in this button.
4.  A file button has been added to the menu bar.  The file button allows you to file items in internal
memory or on a memory card.
5.  Some features available in the Action button now have icons associated with them. To see the new
icons tap the Action Button.

Hiding and Restarting Notion
The Hide feature and the Notepad button have been restored in this version.  For instructions on using the
Hide feature, see "Hiding Notion" above.  For instructions on activating the Notepad button to quickly
restart Notion, see the "Preferences" chapter.

Entry Slip

1. Diamond lists now include an "Add to <diamond> list" item. This takes whatever is currently in the
entry area and adds it to the diamond list.

2. Date/time fields automatically insert the current date/time when they are opened.

3. Name, phone, and address fields now include a button to bring up the Newton's built in Name File. This
lets the user choose from the names in the Names application.

4. Phone and address fields which follow a Name field will automatically be filled in with the information
for the selected person, if the Auto-Fill feature is enabled in Prefs and the Name field is filled in using the
Name file.

5. Alarms may be set on an individual item, using the alarm button in the entry slip.



6. Items may be linked to the Dates application.

Miscellaneous

Notion 1.5 includes an online help reference, accessed through the Info button.

Text can be dragged into Notion from the Newton's clipboard. If it is dropped onto the list itself, it will be
imported as tab-delimited text.

You may now select from three font sizes for your lists.  See Preferences.

Notion can now connect with your Desktop computer without a Newton Connection Kit.  See the Extras
section for instructions on using Notion Connect.

Getting Started

Screen Description

Here are some of the features of Notion you’re likely to use most often:



When you start Notion for the first time, the Active List contains five lists:

These lists were created with built-in templates. A template is like a printing press, providing you with an
inexhaustible supply of lists. Feel free to delete lists, change their heading, or add items. Their templates
will always be available for creating new, blank lists.

Opening Lists

To open a list, tap on the Active l ist .  Then, tap on the name of the list you want on the pop-up menu
that appears.



You can also open a list by tapping on the Notion Extras button and selecting Manage.  This opens the
Notion List Manager window.  Tap on the name of the list you want to open until it highlights.
Then, tap on the List button and select Switch to List  from the pop-up menu that appears.

Duplicating, Deleting, or Renaming Lists

Use the Notion button to duplicate, delete, or rename the list you're currently using.  Just open the list, tap
the Notion button, and tap the function you wish to occur.

The Notion button also allows you to quickly scroll to the beginning or end of your list.

Entering Information

Entry slips

You use entry slips to add information to a list.  Entry slips contain different fields for entering your
information.  For example, to fill-out a to-do list, follow these steps:

1.  Tap the New button to get an entry slip.

2.  Tap # Priority, and then tap a priority number in the list that appears.

3.  Tap To do to open a new entry area.  Write your entry.



4.  Tap the X to close the slip.  Notion will update your list with the new entry.

Opening an Entry  Slip
To open a new entry slip, tap the New button.  To open a slip for an existing item, tap on the
item on your list.

Changing a list item
You can change any list item by tapping it and then making changes in the entry slip that
appears. The field that you tap will be open for editing when the entry slip appears.

You can change some kinds of fields (those that do not accept text, such as Priority and
enumerated fields) without opening an entry slip. Tapping one of these fields displays a list of
choices. Tap your choice to make the change.
Changing multiple items
You can move through your list with the entry slip open. This is the quickest way to edit
multiple items. To move through your list, tap the arrows at the bottom of the screen. When you
reach the bottom and there are no more items, a new entry slip will open.

Using Notion With an External Keyboard

You can use an external keyboard to quicly enter data into Notion. When you use an external keyboard, you
can use the Tab key to move between fields. If you press the Return key, your item will be added to the
list, and Notion will move to the next item in the list. If you are working with the last item in the list, a
new item will be created.

Fields
Notion has twelve different types of fields for entering information.  A list can contain any combination of
the field types.   The fields in each list are displayed at the top of the screen.

The entry slip for each item also contains the list's fields:



Naming fields

To change the name of a field, double-tap it, and write the name you want in the box that appears.  If the
list is not currently sorted using that field, Notion sorts the list before presenting you with a text box.

The List Designer also allows you to name any field that you create.  See Chapter-- for instructions.

Field Types

Plain text

Use the plain text field for entering any combination of text or numbers.

Number or Currency

The number and currency fields only accept numbers.  The currency field automatically adds the dollar sign
to the number that you enter.  Some templates will automatically total the numbers you enter in this field.
Those that do will have a box  showing the total at the bottom of the list.

When creating a list with the List Designer, you can make the number or currency fields total by selecting
Field is totaled  box in the Edit Field Settings  slip.   See The Notion Extras Chapter for List
Designer instructions.

Name

The first letter of every word entered in the Name field will be capitalized.  This field is linked with the
built-in Names file in the Newton.  To connect to the Names file, tap the diamond in the right hand corner
of the entry slip and the Name file will open.

If you have the Auto-Fill feature in Preferences enabled, you can transfer any name, address and phone
number from the Name file to the Notion entry slip.  Just open a new entry slip and tap the diamond to get
the Name File.  Highlight the selection you want from the Name file and then close it.  The information
will automatically fill in to the name, address, and phone fields in the entry slip.



Phone and address

The address and phone number fields are linked to Newton's built -in Names file.  Just tap the diamond in
the entry slip and the Name file will open.  See above for instructions on transferring information from the
Name file.

Date and Time

The date and time fields automatically insert the current date and time when opened.  You can change the
date or time by scrubbing out the current date/time and entering your own.  You can also make changes
using the calendar or clock, which appear when you tap the diamond in the corner of the slip.

Priority- 1-5, A-E

There are two types of priority fields.  One is numbered one through five, and the other is lettered A-E.
In the entry slip, the priority fields have a pop-up list to select from.  Tap on the Priority field to make the
pop-up list appear, then tap on your selection.
After a list item has been entered, the priority fields can be modified without opening the entry slip.  Tap
on the priority icon on the list and the priority pop-up menu will appear.

Yes/No 

The yes or no field presents a box that is either empty or filled in.   It fills in when you tap on it.

Enumerated

The enumerated field allows you to pick from a specific set of choices.  There is no box for entering text in
the entry slip for this field.  Instead, you must choose from the diamond  list which appears when you tap
on the field.  See below for instructions on creating diamond lists.

After a list item has been entered, the enumerated field can be modified without opening the entry slip.  Tap
on the enumerated icon on the list and the pop-up menu will appear.

Diamond Lists

If you frequently include recurring information in your list entries, you can speed up the entry process by
creating a diamond list containing that information.

For example, if you have several colleagues that you often call for information, you can add their names and
phone numbers to the entry slip of your “Calls to make” list. Then when you update your list, you can use
the entry slip to quickly add the information you need.

Diamond lists appear as a pop-up menu when a field is tapped on.

Creating diamond lists

1.  To create a diamond list, first open an entry slip.
2.   Tap on the field for which you want to create the list.



3.  Tap on .  The Diamond list items  window will appear:

4.  Tap on an
entry area to open a text box, then enter your items.



5.  Tap Save before closing the window.  Your list will appear as a pop-up menu when you tap on it's field
in the entry slip.
c.  Using and modifying diamond lists
Fields that have diamond lists have a diamond icon in front of the field name in the entry slip.  Tapping on
the field name will make the diamond list appear.

Tap to select an item on the diamond list and it will automatically fill-in to the entry slip.
To make changes to an existing diamond list, open the diamond list as described above.  The Diamond
list  i tems  window will appear when you tap  Edit  list.
To quickly add an item to an existing diamond list, first enter the item you want to add into the field's entry
slip.  Then open the diamond list and tap on Add to  list.  The item will be automatically added to the
list.

Using the Call button

If an item includes a name field, the Call button will be present at the bottom of the entry slip. The call
button allows you to quickly access the Newton's Call slip.

When you tap on the Call button, Notion activates the Newton's Intelligent Assistant to bring up the Call
slip. The call slip gives you the telephone number of the person you are calling, as well as dialing
information. If you are connected to a modem, the call slip can also dial the telephone.

When you tap the "Call" button in the Call slip, the Newton's Call Log application is opened. This
application allows you to keep track of telephone calls. For information on using the Call Log application,
please see the documentation which came with your Newton device.

Setting An Alarm on an Item



Any list item can have an alarm attached.  The alarm button is located in the entry slip.

To set an alarm:
1.  Tap on the alarm button and a menu appears:

2.  Tap on Set alarm to get the alarm window.

3.  Tap on Alarm time to get the pop-up calendar/clock:

4.  Close the pop-up window and tap Alarm on.  Your alarm is set.

Linking an Item to the Date book

You can use the alarm button to add a list item to the Newton's built-in Date book. Tap on the alarm
button and select Add to dates.  Then choose the date you need and close the calendar pop-up.  The
Event window in the Date book will open with your item and date filled in to the Title  and Date slots.
See your Newton manual for further instructions on using the Date book.

After you have added an item to the Date book, the alarm button menu changes, allowing you to quickly
remove the item or access it within the Date book:



Creating sticky notes

Each entry slip has a “sticky note” associated with it. You can write or draw anything you like on the note
and it will always “stick” to this item.

The sticky note button in the entry slip changes if the note has something in it.
Sticky note with information

Empty sticky note

To write or view a sticky note, tap the item in the list to bring up the entry slip. Then tap the sticky note
button.  Write your information in the Sticky Note window that appears.

Printing/Faxing sticky notes

To print a sticky note, open the Sticky note  window and tap the Action  button.   Select Print item
or Fax from the menu that appears.

Working with list items

Sorting

Sort your list by tapping the title of the field that you want to sort.

Text fields are sorted as follows: punctuation marks come first, followed by numbers (from 0 to 9), spaces,
letters (from A to Z, disregarding capitalization), and special characters.
Dates and times are sorted in chronological order.

Checkboxes

Using checkboxes



Each list entry has a checkbox. Notion does not give checkboxes any special meaning, so you can assign
checkboxes any meaning you like from list to list. For example, you can use the checkbox in a to-do list to
indicate you’ve done that item, or the checkbox in a grocery list to indicate you’ve found that item.
To check or uncheck an item, tap the dotted box to the left of the item.

Note:  If you check an item, the checkmark stays until you remove it, even if you go to another list.

Checkbox  actions

Tap the checkmark button to see the actions you can perform on checked items.

Tap here to show all
items in the current list.

Tap here to show only
unchecked items.

This picture appears near the title of any list that contains
hidden checked items.

Archiving Items

You can remove items from a list without deleting them from Notion. If you have completed to-do items,
for example, you can move them from your to-do list into an archive to keep a record of tasks you’ve
completed.

Creating an archive

Before you can store list items in an archive, you need to create an archive for that list.  Follow these steps:

1. Go to the list you want, then tap   .

2. Tap Create archive list.

Storing items in an archive

To store items in an archive, follow these steps:
1. Go to the list you want.
2. Make sure that the items you want to store are checked.  To check an item, tap the dotted box to
the left of the item.
3. Tap the checkmark button, then tap Archive checked items.



Notion will then move the items into an archive list.

The archive list has the same name as the list you’re working with, followed by the word “archive.”
Archives are not included in your Active List. To see them, you can use the Manage utility.  See Chapter-
- for instructions.
Selecting, unselecting, and deleting items

Selecting items

Notion allows you to select multiple items in a current list so that you can perform actions on them as a
group.
In most cases, you can select items as you would in the Notepad.   Selected items appear highlighted.
• To select a single item, hold the pen down until you see the highlighting mark. When you lift the
pen, the whole item is selected.
• To select another item, repeat the procedure.
• To select multiple contiguous items, hold the pen down until you see the highlighting mark. Then
draw through the items you want selected.
• Tap Select to get a menu of convenient shortcuts for selecting groups of items.

Unselecting items

To unselect items, use the same procedure you used to select them.

Deleting items

To delete an item on your list, scrub it out.  To recover an item that you accidentally scrubbed out, tap
Undo.

To delete information in a specific field without deleting the whole item, tap the item to open the entry
slip. Then scrub out the information you want to delete.

Move list items between stores

You can file list items internally or on a memory card by using the file button.  select the items you want
with the select function (see above), then tap the file button.



Choose how you want your selected items filed then tap File.

Notion Extras
Use the Notion Extras to create new lists, to move items from one list to another, or to connect
Notion with your desktop computer.  Also, the Manage feature allows you to easily duplicate,
rename, and delete lists, or to modify your Active List.

Creating new lists

You can create a new list from a template using Browse, or from scratch using the List Designer.

Browse

Notion includes dozens of templates for your use. They’re organized into categories to make it easier for
you to find the one you need.

These categories are stored in Newton as “packages.” If you purchased Notion on a floppy disk, you can
install any or all of these packages on your Newton’s storage card or internal memory.

Warning:  If you purchased Notion on a card, don’t delete the template packages from the card. If you do,
Notion will not be able to create new lists using those templates.

1 Tap the Extras button at the bottom of the screen, then tap Browse.

2 Tap Categories,  then tap the category of list you need.  The categories include the built-in 
lists, the lists included in the Template package, and any of your existing lists.



3 Select the template you want by tapping on the name until the highlighting mark appears.
If you don't see a template that exactly matches what you want, remember that you can change the
field names as needed.  For example, if you are interested in keeping track of your first-edition 
book collection, you might start with the Comics template and then change the names to suit.

Here are the things to look for in selecting a template:

• Number of fields:    Decide how many pieces of information each item should contain. If you
need to have a catalog number, a title, a value, and a cost field, make sure your template has four fields.

• Types of  f ields:     Make sure the types of fields you need, like numbers, dates, or phone
numbers, exist in the template.

• General layout:     Make sure the fields are arranged the way you need.

4 Tap Create list.
5 Name your new list in the entry slip that appears, then tap Create.



List Designer

You can use List Designer to create your own list templates.  In Designer, you can create layouts using any
of the twelve fields.  You can create a layout from scratch, or use an existing Notion list or template as a
starting point.  Once your layout is exactly the way you want it, you can then use it to create a new list.

Note that you cannot modify an existing list directly.  If you want to add or change fields in an existing
list, you can use that list as a starting point for creating a new layout with Designer.  Then you can use
Converge (see below) to copy your old list contents to your new one.

To start List Designer, tap on Design in the Extras menu.

 Choosing your starting point

With designer, you can create your list from an existing list or template, or from a blank layout area.
Notion will give you a blank layout area as a default when you start the Designer.

Sometimes, you'll realize that an existing list or template would be "perfect" with some minor adjustments.
You can use that list and The Designer to make a customized list that suits your needs.

To start your layout with an existing list or template, tap on the Start/Create button.



The Designer screen

The Designer screen is where you create your layout.  In addition to the title and status bar, the Designer
screen has three main areas:

Here are some of the features of Designer you're likely to use most often:



As you drag fields, you'll see areas of the screen highlight to show you where the field will be placed.  If
you drag a field to either side of an existing field, half of that field will invert to show you on which side
the new file would land.

You can use either one two, or three lines in your layouts, but your fields must fill any line they occupy.
Designer will assist by resizing fields as best it can to make things even out.  Any blank lines you leave in
the layout area will be collapsed when the list is saved.

Tap on the field name in the layout area to change it's name or other characteristics.



Once a field is complete and named, tap the Start/Create button and choose Create List from
Layout to create a new list.

Editing Fields
You'll find that the default names and characteristics that Designer supplies for fields are often sufficient.
Sometimes you'll need to edit them, which you can do by tapping the field to select it, and then tapping the
Edit field button.  You can also edit a field by tapping on an already selected (highlighted) field.

Note-You can only total Number or Currency fields.

Connecting with your Desktop Computer

Using Notion Connect

Notion Connect is a Notion Extra which allows you to easily exchange data between Notion and desktop
computer systems. It uses a direct connection to the desktop computer, so no other software is required.

Notion data are translated into tab delimited text, a format which is read by most desktop databases and
spreadsheets.

The Notion Connect system consists of a Macintosh or Windows server, and a Newton client. Data may be
exchanged between the Macintosh/PC and the Newton through text files, or through the desktop computer’s
clipboard.

Macintosh: To use the Macintosh Notion Connect, both your Newton and your Macintosh must be
connected to a LocalTalk network. All Macintosh computers include LocalTalk networking—if you are not
connected to a network, use the Macintosh’s chooser to turn on AppleTalk, and connect the Newton via
serial cable to the Macintosh’s printer port. For further information about using LocalTalk on the
Macintosh, refer to the User’s Guide which came with your Macintosh.

Windows: To use the Windows Notion Connect, you need to connect your Newton to your PC using an
appropriate cable. The cable which comes with your Newton device is the appropriate cable.

Installing Notion Connect

Macintosh: To install the Notion Connect, you need to copy the Notion Connect application to your
Macintosh hard drive, and download the Notion Connect package to your Newton.

Windows: To install the Notion Connect system, you need to copy the Notion Connect application to
your Windows hard drive, and download the Notion Connect package to your Newton.



After installing the Notion Connect for Windows application onto your Windows PC, you must set the
appropriate Comm port. To do this, start the Notion Connect for Windows application, and select the
“Edit” menu, and “Preferences.” Select the Comm port and click on the “OK" button.

 Importing using Notion Connect for Macintosh

On your Macintosh:

1.  Either save your data, or copy it onto the clipboard.
2.  Open the Notion Connect application and:

If you are sending from the clipboard, select "edit" and "Send from Clipboard:.
If you are sending a file, select "File" and "Open" and open the appropriate
file.

(If you wish, you may drop the file onto the Notion Connect, and it will open
and be ready to send.)

On your Newton:

1. Open Notion.
2. Tap the Notion Extras button, and select Connect.
3. Select the options you wish to use.  They will default to the last options set.

a.  Connect Via: choose AppleTalk for Macintosh.
b.  Connect To:  The name of the last Macintosh connected will appear here.
If you choose "Other Computer," you may specify a Macintosh.

4.  After setting the options, tap “Receive.” If you did not specify a Macintosh 
with the Connect To picker, the Newton chooser dialog will appear.

Importing Using Notion Connect for Windows

Note:  Your Newton must be set to receive before the file is sent from your desktop.

On your Newton:

1. Open Notion.
2. Tap the Notion Extras button, and select Connect.
3. Select the options you wish to use.  They will default to the last options set.

a.  Connect Via: choose Serial.



4.  After setting the options, tap Receive.

On your Windows machine:

1.  Either save your data, or copy it onto the clipboard.
2.  Open the Notion Connect application and:

a.  If you are sending from the clipboard, select "edit" and "Send from
Clipboard".
b.  If you are sending a file, select "File" and "Open" and open the appropriate
file.

Exporting a List from Notion

Data is exported from Notion into tab-delimited text format. You can then either save it as a text file on
your desktop computer, or you can paste it directly into a database, spreadsheet, or word processor.

Exporting using Notion Connect for Macintosh

On your Macintosh:

1.  Open Notion.
2. Tap the Notion Extras button and select Connect.
2.  Select either the File menu and “Receive File”, or the Edit menu and “Receive

to Clipboard”.

On your Newton:

1.  Open Notion.
2. Tap the Notion Extras button, and select Connect.
3. Select the options you wish to use.  They will default to the last options set.

a.  Connect Via: choose AppleTalk for Macintosh.
b.  Connect To:  The name of the last Macintosh connected will appear here.

If you choose "Other Computer," you may specify a Macintosh.
4.  After setting the options, tap “Send.” If you did not specify a Macintosh

with the Connect To picker, the Newton chooser dialog will appear.

If you received the list to the clipboard, simply open your desktop document, and select “Paste.” The
imported list should appear. If you received the worksheet to a file, open the file in your document
normally.

  Exporting Using Notion Connect for Windows



Data is exported from QuickFigure Pro into tab-delimited text format. You can then either save it as a text
file on your desktop computer, or you can paste it directly into a database, spreadsheet, or word processor.

Note:  Your Windows machine must be set to receive before the file is sent from your Newton.

On your Windows machine:

1.  Open the Notion Connect application.
2.  Select either the File menu and “Receive File”, or the Edit menu and “Receive

to Clipboard”.
On your Newton:

1.  Open Notion.
2. Tap the Notion Extras button, and select Connect.
3. Select the options you wish to use.  They will default to the last options set.

  Connect Via: choose Serial.
4.  After setting the options, tap Send.

If you received the list to the clipboard, simply open your desktop document, and select “Paste.” The
imported lists should appear. If you received the list to a file, open the file in your document normally.

Using Serial Import/Export Without Notion Connect

You can exchange data with a computer which does not have the Notion Connect system installed. This is
useful if you wish to transfer data between Notion and a computer which is not Macintosh or Windows-
based. To do this, you must have the Notion Connect package installed on your Newton.

For information on configuring Notion Connect on the Newton, see the previous sections.

Note: This procedure assumes that you have a serial communications program, and are familiar with it. In
addition, you must have a cable to connect your Newton to your computer.

Communications Settings

You should set your terminal program to 9600 baud, No parity, 8 data bits, 1 stop bit, and XON/XOFF.

Importing To Notion

1. Save your desktop document as text.
2. Connect the serial cable from the desktop computer to the Newton.
3. Open your communications program on the desktop computer.
4. Give your communications program the “Connect” command.
5. In Notion, tap the Notion Extras button, and select Connect.   Ensure that the

connection type is set to “Serial”.
6. In Notion Connect, select the options and tap “Receive”.
7. When Notion shows the “Connected” message, send the file from your

communications program as a text file.
8. When your communications program has sent the file, type a carriage return,

and then the ESC key and another carriage return. Notion will then begin to
import the file.

Exporting From Notion

1. Connect the serial cable from the desktop computer to the Newton.



2. Open your communications program on the desktop computer.
3. Give your communications program the “Connect” command. If you have a

“File Capture” option, turn it on.
4. Open Notion to the list you wish to export.
5. In Notion, tap the Notion Extras button, and select Connect.
6. Configure Notion Connect for “Serial” and tap the “Send” button.

Moving items between lists with Converge

You can use the Converge Utility to combine the contents of two different lists. For example, you might
have two lists that contain names and addresses, one for business contacts and one for personal contacts.
You could converge the information from one list to another.  The converge utility allows you to select the
fields you want to transfer. The fields can even have different names, as long as they are the same type.

Managing your lists

The Active List enables you to quickly access your most frequently used lists. When you’ve been using
Notion for awhile, you may want to add a new list to your Active List, or to remove an old one. You may
also want to duplicate a list.  You use the Manage utility to perform these tasks.
To open your List Manager window, select Manage from the Extras menu.  This window appears:



Note:  Removing a list from the Active List does not remove it from Newton—you can always find it by
using the Manage utility.

Setting Preferences
To set the preferences in Notion, tap the Info button and select prefs.

With preferences, you can control these Notion functions:

•  Use the auto-popup preference to make the keyboard or a diamond list to appear when you open 
an entry slip.
•  A Notion icon can be placed at the bottom of your Notepad for easy access to Notion.
You can control the Notepad button's function, or disable the Notepad button.  One 
preference sets the Notepad button to present the Notion Active list when tapped.  The other sets it
to automatically open the most recently used list when tapped.
•  Choose between three font sizes for your lists; 9, 10, or 12 point.
•  Enable the Auto-fill feature to automatically fill in address and phone fields from the contents of

a Name field.



Printing, Exporting and Beaming.

Newton’s standard communication features are available in Notion’s Action button.

Exporting

You can export selected items or an entire list to the Notepad. The information on some lists (e.g. To Do
Lists) can also be exported to other applications, such as Newton’s built-in To Do List.
1 Go to the list you want to export.
2 If you are exporting specific items, select them.
3 Tap the Action button and then tap Export .
4 Select the options you want in the routing slip.



Tap Export to make a
copy of the list in the
area you've selected.

Tap to export sticky notes, too.

5 Tap Export .

Sticky notes are exported only if the "Include sticky notes" checkbox is checked.

Print, fax, beam, and mail

You can print, fax, beam, or mail any list or group of selected items using the Action button. If you have
any items selected, those items will be routed; otherwise, the entire list will be routed.

If you are attempting to print an especially large list, you may encounter memory problems. If this is the
case, you should reduce the number of items you are trying to print, by selecting specific items to be
printed. Using the "Print Later" feature may also prevent printing problems.

You may also be able to increase printing performance by using a package archiving utility, such as
NewtCase.

Warning:  If you beam or mail a Notion list to someone who doesn’t have Notion, that person will be
unable to put the list away. To avoid this, export the list to the Notepad as described above, and then beam
or mail the note. Or mail the information using the Text Only option.

Troubleshooting and Technical Support
If you have a problem with Notion, there are several general techniques which you should try before calling
for help. If the problem appears to be memory related (you see the message "The application does not have
enough memory to do what you asked"), you should try resetting your Newton device by pushing the reset
button in the battery compartment. If the problem persists, you should consider purchasing a utility
package which enables "package freezing," a means of increasing your available system memory.

If you encounter a memory problem while trying to print or fax, you might be able to resolve the problem
by reducing the number of list items you wish to print. You may do this by selecting the specific list items
in Notion, and then attempting to print. Using the "Print Later" feature to print after closing Notion can
also help alleviate memory problems during printing.

If the problem is not memory related, you should try resynchronizing Notion's memory caches. This will
force Notion to rebuild the open list, and also updates the active list.

To resychronize Notion's memory caches:

1. Tap the Info button.
2. Select "About."
3. Tap on the version number in the upper right corner of the about box.



Technical Support

If you have a question and are unable to answer it using the manual or online help, or if you see a Newton
error message (a sound, and a notification saying "A problem has occurred" followed by a number, such as
-48807), please contact us.  To help us answer your question, please have the following information ready:

1. Your Notion version number.
2. Your Newton Operating System version.
3. Steps to duplicate the problem you are encountering.

We are available at the following E-Mail addresses and phone numbers:

CompuServe: 70540,2422
Internet: support@pelicanware.com
eWorld: DonV

Voice: 503-221-1148
Fax: 503-221-8709

In addition, you can contact us in the PelicanWare section of the Newton Vendor Forum on CompuServe
(GO NEWTVEN).

Our US Mail address is:

PelicanWare, Inc.
550 SW Park Ave.
Suite 270
Portland, OR  97205

We hope you like using Notion 1.5!


